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OrCAD PSpice, Capture, and Probe Tutorial

Last Update: 18-Aug-00

© 2000 by Don Peter, Seattle Pacific University

Introduction

With the recent transition of the popular PSpice circuit analysis tool from MicroSim Corp. to OrCAD, inc., there have been significant changes to it, especially with regard to its human interface, i.e., the way a user interacts with and operates the software.   This tutorial has been written to aid those who either have never used PSpice before or have only used the MicroSim version of it (e.g., MicroSim Version 8).  Because of the human interface differences with past versions, even those with prior PSpice experience will benefit from covering this material.  This document is based on OrCAD Release 9.1.

Scope

This tutorial is by no means exhaustive.  The core tool, PSpice, along with its companions Capture (schematic capture) and Probe (graphical output of analysis results) are sophisticated and extensive software packages whose full content cannot possibly be covered in a document such as this.  The goal, instead, is to provide the user with a fairly brief guide that will enable him/her to use this powerful package to model and analyze circuits covered in their engineering education experience at SPU.  Extensive help can be accessed via the Help menus provided in the tools.  Specifically, as part of the Help in Capture there a menu item called Learning Capture, which has lessons and exercises you may use for supplementary learning (Figure 1).  In addition, complete Online manuals are available via one of the the OrCAD Release 9.1 menu selections (Figure 2).  

Contents
We will begin with an explanation of (1) how to get started.  There are a few pointers you will need to follow in order to be able to successfully start the program and analyze your circuit.  Next, we will look at (2) Capture, the tool that allows you to create a schematic.  We will look at the working environment of menus and toolbars and then explore how to actually build a schematic of your own.  Once a schematic has been built, we will be ready to set up (3) an analysis for that circuit.  This will be done using the core PSpice portion of OrCAD.  We will look at how to perform the following analyses: Bias Point, DC Sweep, Transient, and AC.  We will also learn how to set up a parametric secondary analysis as part of one of the four main analyses types. As part of the learning of PSpice use, we will investigate the (4) capabilities of Probe, which is the main tool that makes doing PSpice analyses fun by rendering the results in attractive graphical form.
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Figure 1
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Figure 2

     >>>>>> Let’s Get Started! <<<<<<

How to Get Started

To start a simulation, begin by going to the Start button on the Windows toolbar, then select Engineering Tools, then OrCAD Demo. From now on the document menu selection operations will be depicted by using right arrows (() to show the direction of the menu choices; for example, this first menu selection would be depicted as Start(!Engineering Science(OrCAD Demo.  

Take a moment to survey the choices that are available to you.  The menu items we will look at in this tutorial will be Capture CIS Demo and PSpice AD Demo.  In fact, you will be able to do all of your work via selecting Capture CIS Demo.  If you were to choose OrCAD Release 9.1 then you would be choosing to run the full-blown professional version of OrCAD PSpice.  SPU has a site license for only three concurrently operating versions at once time.  The Demo version is capable of supporting most simulation needs, so there is no reason to use the professional version at this time. This preserves its use for the special cases that really need it.

Once OrCAD Demo is open, you need to set up your circuit project.  Choose File(New(Project.  When the New Project dialogue box appears make sure that “Analog or Mixed-Signal Circuit Wizard” is selected.  This is necessary for doing any PSpice simulation.  Later, when you start placing parts, you must be sure to only use parts from the PSpice libraries.  Type in a name for your project that has clear meaning.  For our first example let’s call it “VoltageDivider”.  Also, make sure that you specify where in your computer’s file system the files for this exercise will be stored.   To do so, you can use the browse button to cause your default directory to be where you want it to be.  A good generic place to put your default directory would be inside the Temp directory on your Hard Drive. In the Engineering Lab the Temp directory is available but isn’t displayed via Browse button.  Just go ahead and type “C:\temp” into the textbox for the location of your project. In general, you may create your own name for the subdirectory under Temp where you want to have your files reside; however, in this example, call it “Voltage Divider”.  After this click “OK”.  Next you will be asked to select the PSpice Part symbol libraries that you wish to use in your project.   Add or subtract libraries until the dialogue box appears as shown in Figure 3 (analog, breakout, eval, source, and special libraries included).  Now Click “Finish”.  This opens the project. 



Learning Capture

Last Update: 18-Aug-00

© 2000 by Don Peter, Seattle Pacific University

Introduction

Once you open Capture, you see the Capture session frame (Figure 4).  You do all of your schematic design and processing within this window.  The minimized Session Log icon in the lower left portion of the Capture session frame is the session log.  The session log provides information about everything you have done in the current Capture session.  Detailed information about this can be obtained in the Online Help mentioned earlier in this document.  In Capture, each design that you open is in a separate project manager window.  Multiple designs can be open simultaneously, but that will not be necessary for us in this tutorial.
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    Figure 4

The Project Manger

Once you start up capture for a particular project, two windows usually open up.  The first is called the Project Manger.  It is used to collect and organize all the resources you need for your project.  These resources include schematic folders, schematic pages, part libraries, parts, VHDL files, and output reports such as bills of materials and netlists.  Figure 5 shows a new project manager window along with the schematic page editor window like your own.  The details of all of these need not be addressed here, but just be aware that they are all part of the Project Manager’s scope.  We will look at a few here.

File Tab  ( 



Hierarchy Tab  (
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Figure 5

The Project Manager’s folders create a logical grouping of resources that is easy to use.  Under the Design Resources folder is the design folder with the design’s schematic folders and schematic pages, and a Design Cache folder that shows all the parts used on the schematic pages.  Any schematic folders or schematic pages that you create are automatically added to the design folder (in our example the the design folder is named VOLTAGEDIVIDER.DSN).  The Library folder (in the Design Resources folder) shows the schematic part library files you’ve added to the project using the Project command on the File menu.  When the need arises it is possible to add additional libraries if other part symbols are needed which are not found in your current list. The Outputs folder shows the output of Capture’s processing tools. Capture adds the appropriate files to this folder as each is created.  The details of this are not important at this time.

** Important NOTE:  A project doesn’t actually contain all resources. It merely “points to” the various files that the project uses.  For this reason, be sure you don’t move or delete any files referenced by a project. If you do, the project won’t be able to find them.  The project files is saved with an .OPJ file extension.  It is an ASCII file, and can be viewed in any text editor.

Each project may have only one design, but may have multiple libraries.  The design may consist of any number of schematics or VHDL models, but it must have a single root module. The root module is define as the top level of the design.

Within the project manager, you an expand or collapse the structure you see by double-clicking on a folder, or by clicking on the plus sign or minus sign to the left of a folder, just like how it works for in Widows Explorer.  Under the project manager’s File tab, double-clicking on a schematic folder expands it and displays icons for each schematic page within the schematic folder.  Then, if you double-click on a schematic page icon, the schematic page opens in a schematic page editor.  Or, if the page is already open, its window becomes active.   A design can consist of a single schematic page witin a single schematic folder, or a number of schematic pages within a number of schematic folders.  A schematic folder “contains” schematic pages in a relationship similar to the relationship between a directory and the files it contains.  We are going to limit our example to single-page projects.  

A schematic page provides a graphical description of the electrical connectivity of a design.  It is made up of parts, wrires, and other electrical symbols.  A schematic page may also contain borders, title blocks, text, and graphics.

Project Manager tabs – File and Hierarchy

The project manager provides two was to display a project’s resources.  If you choose the File tab (shown in Figure 5), the project manger displays all the project’s folders, schematic folders, and schematic pages. These are displayed in a tree-like fashion.  You can expand or collapse the tree by the plus and minus signs, as mentioned earlier.  If you choose the Hierarchy table, the project manager displays the hierarchical relationship among the project’s schematic folders and schematic pages.  Since we will be dealing with single-page examples here, this feature will remain simple, with only one entry.  In more complex projects, or course, this hierarchical view can be very valuable for keeping track of a projects structure.

The Schematic Page Editor

The Schematic Page Editor is used to display and edit schematic pages.  You can place parts, wires, buses, and draw graphics.  The schematic page editor has a tool palette that you can use to draw and place everything you need to create a schematic page.  You can print from within the schematic page editor, or from the project manager window.  Figure 6 shows the simple circuit that we will build in this first tutorial exmple in the Schematic Page Editor.

[image: image5.png]14

=181}

Fle Edt View Place Mavo PSpice Accessories Optins Window Help

o T - Y PN RN e Y 4 [ 2]
=] | 29|
B -ox ~
[ e =
£ Fie |8, Hierarchy = —
= £ Dosin Hesaaces i : = £ i
= SCHEMATICT —
B Pacer 3 =
0 Dedgn Cache 1
i O Lbray R1 453k =
3 Outputs =
-0 PSpice Resouices v s =
DC = 10V 3.32k |
=0 =|
I =
I
2|
=i
o
L

Elofx]

items selected[Soale-200%

220 V=120




Figure 6

Here it is! (




Status Bar (

Capture Toolbar! (
The Toolbar

Capture’s toolbar is dockable (that is, you can select an area between buttons and drag the toolbar to a new location) and resizable, and displays tooltips for each tool. By choosing a tool button, you can quickly perform a task.  If a tool button is dimmed, you can’t perform that task in the current situation.  You can see the toolbar located on the extreme right hand side of  Figure 6.  A tool-by-tool summary of the function of each tool on the toolbar is depicted in Appendix A.   You should survey these pages to get a view of the complete set of tools that are available; however, you will learn their value by actually using them, which we will do shortly.  You can hide the toolbar, then display it again when you need it.  To display or hide the toolbar, from the schematic page editor’s View menu, choose Toolbar.  The Toolbar menu item is a checked item such that when you click on it, it will toggle between on and off (showing or not showing it).

The Tool Palettes

Capture has two tool palettes: one for the schematic page editor and one for the part editor.  We will not be talking about the part editor.  Both tool palettes are dockable and resizable, and display tooltips that identify each tool.   The first group of tools on the tool palette are electrical tools, used to place electrical-connectivity objects.  The second group of tools are drawing tolls, used to create graphical objects without electrical connectivity.  The tools on the schematic page editor tool palette are described in Appendix A also.

The Status Bar

The status bar is located at the bottom of the Capture session frame, and reports on current actions, number of items selected, zoom scale, and pointer location.  

Left field

The left field displays descriptions of selected tols or menu items, prompts, or the current status.

Center field

The center field displays the number of items selected in the schematic page editor or part editor.

Right field

The right field displays the current scale and pointer location (such as Scale=50% X=10.0 Y=5.0).  The location in the schematic page editor is measured in either inches or millimeters, depending on the Units settings in the Page Size tab in the Schematic Page Properties dialog box.  The location in the part editor is measured in grid units.

Building the Voltage Divider Circuit

We are now going to build the circuit depicted in Figure 6.  To do this follow the bulleted steps following:

· Place a resistor on the schematic page.  This can be done in one of two ways.  Your can select Place(Part or you can click on the Place Part icon on the schematic page editor tool palette (the next one below the pointer icon at the top).  In the Place Part dialogue box, under the Libraries box, click on the ANALOG library, then type “R” in the Part: box and then click “OK”.  This will create the symbol for a generic resistor that can be placed in the schematic window.  Move the mouse to a spot where you want to place the resistor, then do a left click to place it.  You can continue to do left clicks and each time a new instance of the resistor will be placed.  

· Before placing the second resistor, right click the mouse.  This will bring up a pop-up menu that allows you to do one of several editing actions.  Chose the Rotate option – this will rotate the resistor so that it is oriented vertically.  Left click to place this second resistor close to the first.  This is depicted in Figure 7.
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Figure 7

· Place a ground reference.  This is done by going through the Place Ground icon on the schematic page editor tool palette (the ninth icon from the top).  In the subsequent dialogue box select 0/Source and click “OK”.  Then place this ground symbol onto the bottom of R4 (your resistor number may differ).   Place a second ground symbol nearby with another click.  It will be used in the next step. 

· Place a DC voltage source.  Go Place(Part, then select SOURCE in the Libraries: box, then type VDC in the Part: box. This will create the symbol for a DC voltage source to be placed on the schematic.  Go ahead and place this symbol with it top connected to R3 and then click on the extra ground symbol and connect it to the bottom of this VDC source.  

· Connect the parts with wires.  Click on the Place wire icon of the schematic page editor tool palette (the icon immediately below the Place Part icon).  This will create a “plus” symbol. Move this to the end of R4 and click, then move the mouse to the right side of R3 and click there.  This should create a wire connection between these two resistors.

· Do a similar action to the previous bullet item to connect a wire between the left side of R3 and the top of the VDC source.  You can end the Place wire operation by either hitting the ESC key or right clicking and selecting the End Wire menu item.  Figure 8 shows how the schematic should appear at this point.
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Figure 8
· Now we need to edit the values of the VDC and the two resistors. Double-click on the 0V value text of the the VDC source.  In the Display Properties dialogue box, type in “10VDC” and click “OK”.  Do a similar operation on the values of R3 and R4.  The R3 value should be changed to 4.53k and that of R4 should be changed to 3.32k.  Figure 9 shows the results.
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Figure 9

Some Words About Editing

There is a wide range of options available to you for doing editing of your circuit schematics.   Some of these editing actions are operated essentially the same as for common windows-based word processors, such as Microsoft Word.   Others are similar to graphical programs such as Microsoft Paint.   Consequently, you will find that many operations will work just as you would expect them to work and can be easily understood and used.  One of the most efficient ways to learn to use these operations is simply to try them out and see what happens!  However, we will go ahead and do an overview of these schematic editing resources in order to gain an overall perspective.

File Menu

Click on the File Menu and let’s look at what it has to offer.  This is depicted in Figure 10.  Look right here! (
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Figure 10
New  ►  This allows you to start a new project or design.

Open ►  This allows you to open a  project or design that already exists.

Close        This will close the schematic editor window.

Save         This will save the present status of the project.

Export/Import Selection and Design items     we will skip these.

Print Preview, Print, and Print Setup   these work like you would expect in Microsoft Word.  Through these you can choose which print to use, the resolution, format, etc.

VoltageDivider.opj  This entry shows which project is open.  If other projects have been opened during your session of using Capture, then their *.opj files will also be displayed.

Exit       This will exit the Capture program

*Note that the underlined characters represent shortcut keys to be able to execute these menu item selections.

Edit Menu

Figure 11 shows the opened Edit menu.  Look right here! (
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Figure 11

In this example, resistor R1 was selected by clicking on it.  The first section of this menu is related to dealing with the last edit operation.  

Undo  *   Undo the last edit operation.  This is written as Undo *   because the second word will vary depending on the context of  the last edit operation.  In Capture, the name of the command changes, depending on what the undone operation was, for example: Undo Rotate or Undo Delete.

Redo  *   Use this command to reverse the effect of the most recent Undo command.  It works just like the Undo command regarding the * second word

Repeat *  Use this command to repeat the last operation on the currently selected object, when the last operation can be repeated. The name of the command changes, depending on what the last repeatable operation was---for example, Repeat Rotate or Repeat Paste. This command is most useful for placing objects and creating arrays of objects quickly.

You can control the spacing between placed objects using the Repeat command by pressing the CTRL key and dragging a copy of the object to a new location before using the Repeat command.

Cut, Copy, Paste, and Delete  These operate essentially as you would expect for a word processing program. They are active (not dimmed) when a part is selected (like R1 in Figure 11).

Select All    This selects all of the parts on a schematic, as expected.  The rest of the selections in this subsection of the Edit Menu will not be covered here.

Mirror and Rotate  Allows you to manipulate a part with regard to its orientation on the schematic.  Go ahead and place  a new resistor and try these  to see what happens.

Find and Global Replace   Find allows you to have Capture find on your schematic page the location of a specific component.  Try it on our simple example (like find R1) and see what happens.  It should adjust the view so that R1 is clearly visible.  This is especially helpful for more complex circuits where much of the circuit is not visible in the widow.  Global Replace refers to objects that we have not covered, so we will skip them.

If you Right Click on a part that has been selected will bring up a pop-up menu which will allow you to perform the same set of operations that we have just explored via the Edit menu.  Go Ahead and look at it.  If the part is NOT selected, then you get a truncated menu.

View   Menu
This is fairly straightforward.  It deals with the Tool Palette, Toolbar, and Status Bar and their visibility, the grid, going to specific locations on the schematic page, and zooming controls.  This menu is shown in Figure 12.  Look right here! (
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Figure 12

Place Menu

The operations available via this menu offers an alternative way of executing the edit functions available via the Schematic Page Editor Tool Palette.    Go ahead and look at them and compare with the tooltips you see when you place the point on the Schematic Page Editor Tool Palette icons.  This menu is shown in Figure 13.  Look right here! (
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Figure 13
Other Main Capture Menus

The other menu items will not be covered here except for the core PSpice menu.  These others are not major factors in most things you will do and can be learned later when the need arises.

Moving Parts

Since this is such a common operation in editing circuits, let’s take a closer look at some basic operations.  You can easily change the location of objects in the schematic page. Immediately after you place an object, you need to select the selection tool or press ESC before you perform the steps below.

Capture uses the location of the first pin on a part to snap to grid. If you move a part without pins, it will be off grid unless you use the Cut command described below to place the part on grid.

To drag an object using the mouse

Position the pointer on the object. Press the left mouse button and drag the object to the new location. Moving an object this way does not break any of its electrical connections, with the exception of pin or net symbol connections. Otherwise, electrically connected objects are rubberbanded to maintain connectivity.

If you are dragging a part or wire to another location and that change will affect connectivity, Capture warns you with a changed cursor and temporary markers on your schematic. Visible and off-screen connectivity changes will be saved in the session log if you complete the operation.

To move an object using the mouse

1  Move the pointer over the object.

2
Simultaneously press ALT and the left mouse button, and then drag the object to the new location.

3
Release the mouse button. The object is placed at the new location. Nets previously connected to the object are not moved.

To move objects using the Cut command

1 Select the object or objects.

2
From the Edit menu, choose the Cut command. The object is placed on the Clipboard.

3 If the object is to be moved to another window, open that window.

4 From the Edit menu, choose Paste. The object is attached to the pointer.

5
Move the pointer to the location where you wish to place the object and click the left mouse button. The object appears in the selection color.

6 Click an area where there are no parts or objects to deselect the object, or press ESC.

Selecting Multiple Components

You can select a component by clicking on it.  You may select addition components by holding down the CTRL key and clicking on them.  A  second click on the same component will de-select it.  Also, once you have selected a group of components you can cancel all of the selections at once by pressing the ESC key.  Another convenient method is  to use the mouse by clicking and holding down the left mouse button and dragging the mouse to form a rectangle around a group of components.  This will select the whole set of components as a group.   Once selected this group can be moved together by dragging with the mouse.  Pressing the ESC key will, of course, de-select the group.

Zoom and Title Block

Make sure that you are familiar with the zoom capabilities in Capture.  The Toolbar contains Zoom In and Zoom Out icons which allow you to change the size of the view you get of the schematic page. If you have not already, go ahead and try them to get a feel for how they work.

The Title Block allows you to include documentation that clearly identifies your schematic.  The Title Block is found in the lower right corner of the schematic page.  Go ahead and move the view on you schematic page so that the Title Block is visible.  See Figure 14 for how it may look.   Look right here! (
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Figure 14
Fill in an appropriate title by double-clicking on  “<Title>” field and type it in. Include your name. Note that the date is already entered for you in the Date field.   You may also fill in the Document Number.  In this case there is only one schematic page, so the number is trivial (like “No. 1”).   It is  a HIGHLY RECOMMENDED practice to take care of this documentation step.  You will be EXPECTED to do this in any Capture work you do for your classes.  Figure 15 shows the results of this documentation step.   

Look right here! (.  Use Edit(Find (R1) to move the view to the voltage divider.

Figure 15 
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Adding Text

Let’s make use of the text tool on the schematic page tool palette. It is found at the bottom of the icon bar.  When you click on this, the dialogue box appears where you can fill in  the text you would like to have displayed on the schematic page.  Let’s say “This is my first circuit!”.  Let’s also change the font type and size.  You can do this by clicking on the Font Change.. button.  The dialog box that appears will allow you to change the font size (make it 12) and the style (Bold Italic) and the font type (your choice – be creative!).  

Figure 16 below shows an example of this step.  Look right here! (
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Figure 16

Let’s Do Some Circuit Analysis!

Now that we have covered the overview of Capture, we are ready to do some circuit analysis vie the PSpice Menu in Capture.  As mentioned at the beginning of this tutorial, we will be covering the following circuit analysis options: Bias Point, DC Sweep, Transient, and AC.

Simulation Settings:

To set up your simulation (this must be done to run one), choose “New Simulation Profile” from the PSPice menu.  Enter the desired simulation name (VoltageDivider in this case), then click on “Create”.  The next dialog box that appears is the main one for making all of the settings for your particular analysis.  This can be viewed in Figure 17.  

Look right here! (
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Figure 17

There are many different settings you can make via this dialogue box; however, at this point we will only look at four of the eight tabs available since they have the most relevance to basic circuit analysis.

Analysis  This tab is the one that we will use the most. It is enabled in Figure 17.  It allows you to select the Analysis type, the analysis options (sub settings for an analysis),  plus a set of specific settings that are unique to each analysis type. The example of Figure 17 shows Time Domain (Transient) analysis selected and its unique settings the amount of time to be simulated (Run to time), the start time for saving data (Start saving data after),  the maximum allowed simulation time step size (Maximum step size), and a couple others.

General    This tab allows the user to view and change some general information regarding the analysis (Name, etc.).  Usually nothing here needs to be changed, even though in the example shown, some notes have been added. See Figure 18.

                                Look right here! (
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                                          Figure 18

Data Collection   This tab gives access to controlling how data is collected during your analysis.  You can choose to have all node voltages and currents collected, or to suppress internal node data, or to collect data for node marked with what are called Markers.  Any limitation on data collected will speed up the analysis run itself.  This is generally desirable to save time, even though there can be times when gathering all of the data is needed.  This tab is shown open in Figure 19.  Go ahead and look at it yourself on your computer.  Look right here! (
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                                           Figure 19
The Probe Window tab allows you to specify how you want the graphical results program Probe to handle what it displays and when.  The options here are pretty obvious, especially after you become familiar with the Marker tools.  This tab is show in Figure 20.  Look right here! (
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Figure 20

Bias Point Analysis

By selecting Bias Point analysis you will see the dialogue box shown in Figure 21.

Look right here! (
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Figure 21

You can click on the three check boxes in the “Output File Options” area, but we need not deal with these now.  The same can be said for the “Options” box. Simply by selecting the Bias Point analysis type, we are ready to do this simple analysis.  Go ahead and click the “Run” menu item on the PSpice Menu.  They analysis will now be done.  After it has finished, a new window will appear.  Select on Simulation(View(Output File.  This will show the output results of the analysis.  In this simple case, there will be no Probe graphical result.  This is shown in Figure 22.  Look right here! (
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Figure 22

Let’s take a look at this output file.  With the advent of a graphical windows-based versions of PSpice replacing MS-DOS based versions, the text files  have tended to be largely ignored; this is unfortunate because the underlying base for the newer versions remains as text code.

The first section contains text PSpice codes that set up the circuit description.  Here is the first part (I have omitted the header commentary to save space). Comments of are in bold font:  

** WARNING: THIS AUTOMATICALLY GENERATED FILE MAY BE OVERWRITTEN BY SUBSEQUENT PROFILES

*Libraries: 

* Local Libraries :

* From [PSPICE NETLIST] section of pspice91.ini file:

.lib "nom.lib"       

*Analysis directives: 

.PROBE                               Probe program is enabled (though not used this time)

.INC "voltagedivider-SCHEMATIC1.net"    The net list that was created by the analysis
Here is the net list for the circuit

**** INCLUDING voltagedivider-SCHEMATIC1.net ****

* source VOLTAGEDIVIDER

R_R1         N00034 N00023  4.53k  

R_R2         0 N00023  3.32k  

V_V1         N00034 0 10V

Here are the alias descriptions (e.g. R1 is the alias for R_R1)

**** RESUMING voltagedivider-SCHEMATIC1-VoltageDivider.sim.cir ****

.INC "voltagedivider-SCHEMATIC1.als"

**** INCLUDING voltagedivider-SCHEMATIC1.als ****

.ALIASES

R_R1            R1(1=N00034 2=N00023 )

R_R2            R2(1=0 2=N00023 )

V_V1            V1(+=N00034 -=0 )

.ENDALIASES

Here is the bias point analysis result, showing the DC voltage at the common node between R1 and R2 (N00034) is 4.2293 volts.

**** RESUMING voltagedivider-SCHEMATIC1-VoltageDivider.sim.cir ****

.END

**** 08/11/00 14:20:22 ********* PSpice 9.1 (Mar 1999) ******** ID# 1091600154 

 ** circuit file for profile: VoltageDivider 

 ****     SMALL SIGNAL BIAS SOLUTION       TEMPERATURE =   27.000 DEG C

******************************************************************************

 NODE   VOLTAGE     NODE   VOLTAGE     NODE   VOLTAGE     NODE   VOLTAGE

(N00023)    4.2293 (N00034)   10.0000 

Finally, we see the current, power and job time for this analysis.

    VOLTAGE SOURCE CURRENTS

    NAME         CURRENT

    V_V1        -1.274E-03

    TOTAL POWER DISSIPATION   1.27E-02  WATTS

          JOB CONCLUDED

          TOTAL JOB TIME             .01

The primary piece of information is, or course, the value of the voltage on the voltage divider of R1/R2 when 10 volts dc is applied to the input.  It is listed here are 4.2293 volts.  Check this number with your calculator with the resistor values as defined here of 4.53k and 3.32k.  What do you expect it to be?  Now take  a look at your circuit in the schematic window you will see that it now has the DC voltage levels indicated.  This is shown in Figure 23.  Look right here! (
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Figure 23

DC Sweep Analysis
The DC Sweep Analysis has the purpose of providing in one analysis a complete set of DC voltage bias levels and currents for all circuit nodes for a user-defined range of voltages.  This is useful when determining, in general, characteristics for circuits with non-linear components (like diodes and transistors) and also for the bias characteristics for amplifiers.  Even though the DC voltage level is swept through a range of values, each discrete value of voltage in the sweep is evaluated as  a true DC value. In other words, there are no DYNAMIC characteristics associated with the circuit, like time constants, delay times, etc.  

For our circuit lets set up the DC Sweep so that we can see what happens to the voltage divider as the input voltage sweeps from 0 to 10 volts.  

Do the following to set up the sweep:

· Choose PSpice(Edit Simulation Profile(Analysis Tab.  Select DC Sweep as the Analysis type.  

· Set the Sweep variable to Voltage and Sweep type to Linear. The Sweep variable name should be “V1” or whatever name you have for your DC voltage source.  Set the Start, End and Increment values in the Sweep type box to be 0, 10, and 0.1 volts, respectively.

· Click “OK”

· Select “Run” from the PSpice menu.  The DC Sweep analysis should now run.  This will reveal a blank graphic screen as indicated in Figure 24.  Here it is! (
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Figure 24

Now go Trace(Add Trace.  This will bring up the Add Trace dialogue box.  Click on V(V1:+) and the “OK”.   You then will see the trace for the sweep of the DC voltage source as it swept from 0 to 10 volts.  Next, go Trace(Add Trace again this time choose V(R1:2) the click “OK”.  This will add a trace to the Probe screen which shows the sweep of the voltage divider output.  Note that it follows a linear path that exactly matches what you would expect from a voltage divider. Admittedly, this is not very spectacular, but it clearly illustrates the nature of the DC sweep.  Figure 25 shows this result.  Here it is! (
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Figure 25
Wouldn’t it be nice to be able to have the Probe graphic screen come up initially with the sweeps we see in Figure 25?  Fortunately, this can be easily set up.  Go to PSpice(Markers.  Note that in this submenu you can make selections of adding voltage, differential voltage, and current markers, along with some additional secondary options. For this case, choose a voltage Marker. This choice will cause a marker symbol to appear on the schematic window.  Use the mouse to place it on the common node of R1 and R2.  Repeat this process to place another voltage marker on the positive end of the voltage source.  Go PSpice(Edit Analysis Profile(Data Collection and choose At Markers only.  Now run the DC Sweep  analysis again.  Note that this time the sweeps shown in Figure 25 are automatically displayed. Now we can use the Net Alias tool to attach to the common node of R1/R2.  How do you do this?  Go Place(Net Alias  or click on the Net Alias icon from the schematic page toolbar palette.  After clicking on this icon, type in the name of the net – in this case, call it “Vout”.  Next, move the symbol to the node of interest and click on the net (wire). Next, run the DC Sweep again.  Note that now VOUT is now the label for the voltage divider output. 

Let’s do one more thing with this example.  Click on the Text icon of the Probe toolbar.  It is the one with “ABC” on it and can be found in Figure 25. Create a text message like “Voltage Divider DC Sweep”.   Place it somewhere on the graphic display.  Do the same for a couple more messages similar to those seen in Figure 26.  Next, Go Plot(Label(Arrow. This allows you to create an arrow to point from the text label to its associated trace. This is a very useful tool for clarifying multi-trace Probe displays. This can also be seen in Figure 26.  
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      Figure 26

Showing Variable Component Value Effects

The two resistors used in this example are 1% tolerance parts.  That means that their actual values are guaranteed by the manufacturer will be within (1% if nominal (named) value.  For example, with the 4.53 k(  resistor (R1), with a 1% expected variation that would mean that the actual value could vary from 4.485 k( to 4.575 k(.  However, in real designs, the practical rule of thumb is that the % tolerance should be doubled to take into account other factors associated with aging caused by temperature cycling, voltage stresses, etc.  That means that a 1% resistor should be designed into a circuit with the expectation that it could vary as much as (2% over the life of the design.  We can use the DC Sweep analysis to investigate how this variation can affect the voltage divider output.  One way to do this would be to set up three parallel voltage dividers, one that will represent the nominal resistor values, one that will represent the case of creating a minimum output voltage, and the third representing the maximum output voltage.  This parallel circuit can be seen in Figure 27.  

Here it is! (
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Figure 27

Now run the DC Sweep.  The results show the sweeps for all three of the parallel circuits.  This is shown in Figure 28.  
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Figure 28

The problem with this result is that the three divider outputs are bunched together and are difficult to read. This situation can be improved. One way to do that is by deleting the sweep trace for the input voltage from the DC voltage source. How is this done? Click on the NAME of the input voltage sweep (yellow in Figure 28) and press the Delete key on the keyboard of do a  CTRL-X on the keyboard. The result is a reduced ‘Y’ axis  range. From this we can see that the output voltage at 10 volts will range between about 4.2 volts and 4.4 volts throughout the life of the design, assuming of course that the input voltage will be exactly 10 volts! (probably a bit too optimistic). 

We can do additional things to adjust the display range, both on the ‘Y’ and ‘X’ axes, by utilizing the Plot( Axis Settings menu items in the from the Probe toolbar.  Check out the X axis controls and note that you can set the range your self to whatever you want it to be. You can also set the scale as Linear or Logarithmic.  You can change the Y axis name. In this example, it is named “Divider Output Voltages”.  In this example, the X-axis range is set to be 6.0 to 10.0 volts and the Y-axis is set from 3.0 to 5.0 volts. This is illustrated in Figure 29.  
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Figure 29

Time Domain (Transient) Analysis
The Time Domain, or Transient Analysis has the purpose of  predicting how a circuit will respond to a transient event, like a step input.  So this would be he method for doing  a step response analysis.  For the purposes of exploring this method we will build a  new circuit, a simple RC network.  As part of the exploration we will also introduce the Parametric Sweep Option to the main analysis type. This option allows you to vary a component value over a user-defined range without having to create a parallel circuit for each instance of the components value range. This is a convenient way to analyze the effects of a single component on the overall behavior of a circuit.

The start with, build the circuit that is illustrated in Figure 30.    To do this start a new project called RC_Circuit.  In so doing, put this project in the subfolder of the temp directory and call it RC_Ciruit also.  A new factor here is the placing of a capacitor; yet, it works just like the process of placing a resistor.  Another new factor is the use of the VPULSE voltage source.  How do you place such a part?  

· GO Place(Part and select the SOURCE library in the dialogue box.  Then type in VPULSE as the type of source desired. This will produce a VPULSE symbol, which you can place like other components.  Then you can double-click on each parameter listed with this source and fill in the values shown in Figure 30.  Here it is! ( 
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       Figure 30

Let’s take a moment to look at the parameters shown on the VPULSE source.

V1 = 0

For the pulse, the beginning voltage level

V2 = 1

For the pulse, the ending voltage level

TD = 0

The delay time of the pulse, from the simulation starting point (0 seconds)

TR = 0

The risetime 

TF = 0

The falltime

PW = 3u
The pulse width

PER = 6u
The period of the pulse 











Now go PSpice(New Simulation Profile. This brings up the Simulation Settings dialogue box. Choose Time Domain analysis and set the Run to time: 6000ns.  Before running the simulation, put a voltage marker on the non-grounded end of the capacitor C1.  Set the Data Collection tab setting to At Markers only.  Now run the analysis and see what happens.  The result of this analysis is shown in Figure 31.  This Probe display is also documented with text and arrows.  Here it is! (
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Figure 31
AC Sweep/Noise Analysis
The AC Sweep/Noise Analysis allows you to simulate the frequency response of your circuits.  

Create a circuit as shown in Figure 37.  This is the classic series RLC circuit.  We will do a frequency response, taking the output across the 1nF capacitor, thus the voltage marker set on the capacitor.
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Figure 37

The Vac source will provide an ac signal over a band of specified frequencies in this simulation.  You can change the magnitude of this source signal by double-clicking on the value and changing the value in the dialogue box.   It is also possible to set a DC voltage value to this source as well, to simulate an offset bias voltage if desired.

To set up the AC analysis in PSpice do the following:

· Go PSpice(New Simulation Profile. Give it the name “RLC_Circuit”.  Select AC Sweep/Noise and fill in the parameters as shown in Figure 38.
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Figure 38

· Now select Run and let the analysis run.  The result should look like Figure 39.  
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Figure 39

The Magnitude Frequency Response is often depicted in decibels (dB); PSpice provides an easy way to do this once the AC (Frequency) Response has been run.  In Figure 39 the trace being shown if for what is called V(C1:2), that is, the voltage on pin 2 of Capacitor 1.  The get a trace for this same voltage in dB you simple go Trace(Add Trace, then select “DB()” from the Analog Operators or Functions menu box on the right hand side of the Add Traces dialogue box.  When you click on “DB()” that function will be placed in the Trace Expression text box at the bottom.  Next click so that the text cursor is place inside the DB() parenthesis, then go up and click on “V(C1:2)” in the Variables menu box..  This action should cause the Trace Expression to read “DB(V(C1:2))”, which is telling the system to convert that variable to its decibel equivalent.  Now click “OK” and this new trace should be displayed on the graph As shown in Figure 40.
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Figure 40
You can make adjustments to the X and Y-axis ranges by going Plot(Axis Settings…In the Axis Settings dialogue box, you can set various parameters like linear vs logarithmic scales, or autorange or a user defined range.   Delete the linear version of the frequency response trace, then set the frequency range 30 kHz to 778 kHz and the Y-axis range to –20 dB to +40 dB.  See that in Figure 41.  
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Figure 41

Note how sharp the resonance peak is on this figure.  This is because we only asked for 50 data points per decade; by changing it to 300 points per decade and focusing in on the frequency range of the resonance peak, we get a smoother result as shown by Figure 42.  
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Figure 42

If you would like to see the actual data points, then you can click on the Mark Data Points icon on the Probe toolbar (just to the right of the ABC, text, icon).  Go ahead and try it.

Let’s say we would like to find the peak value of  this frequency response curve.  This can be done via the use of the cursor tool provided by Probe.  Here’s how to use it:

· Click on  the Toggle cursor icon which is directly to the right of the Mark Data Points icon.  Two cursors are available through Probe and they will now be accessible.  They are called A1 and A2.

· By right-clicking on the mouse you choose A2 and by left-clicking on the mouse you choose A1.   Click on the Cursor Peak icon, which is just to the right of  the Toggle Cursor icon, this will place the cursor (vertical and horizontal  crosshairs) at the maximum point.  

· Next click on  the Mark Label icon, which is the rightmost icon of the Probe toolbar.  This will fix a label to this maximum point.

· Note that you can utilize the cursor-related icons to cause the icons to move to other points, like the Cursor Trough, Cursor Slope, etc.  You may investigate these on your own time. You can also move the cursors  by moving the mouse.  The move A1 cursor, hold down the left mouse button. To move the A2 cursor, hold down the right mouse button.  Note that the difference between the two cursors is displayed as part of the Probe Cursor box.

See the results of this in Figure 43.  

[image: image37.png]M fex %¢ B |5 2% 8 >

591633K, 25,933

50KHz 100KHz 150kHz 200KHz 250KHz 300KHZ
DB(U(C1:2))

Frequenc:





Figure 43
This wraps up our portion of AC (Frequency Analysis).

PSpice and Active Components

Doing simulations with active components (diodes, transistors, op amps, etc.) is fundamentally no different than simulations with solely passive components.  However,  it may be helpful to do some examples with active components and along with them, investigate some more PSpice capabilities.

Op Amp Simulation

Let’s do a simulation that uses operational amplifiers.  First, let’s start by creating a  simple unity-gain amplifier using the LF411 JFET op amp.  One resource shown here is how to create a net alias.  When you create the Project for this example (call it “OpAmp” and create a folder for it).  Also, make sure you include the opamp.slb library.  Our input will be a VPULSE  source.  See Figure 44. Here it is! (
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Figure 44
This illustrates the creation of net alias.  In this case we want to have the DC power supplies connect electrically without actually connecting them with a wire.  This is done via the net alias feature.  Here is how you do it:

· Place the parts on the schematic page. In this example, it would be the op amp, the two DC voltage sources, and the VPULSE source.

· Go Place(Net Alias… In the dialogue box, type name “+10V” on the positive end of the +10V source and click “OK”.  The net alias box appears.

· Place the mouse pointer on the net at the positive end of the +10V source and click. This will place the alias name on that net.  

· Next, place the mouse pointer on the net of the V+ pin (7) of the op amp and click.

· Do the same process of placing “-10V” net alias on the positive end of the –10V dc source and the V- pin (4) of the op amp.

Now PSpice will consider these nets to be electrically connected.   Go ahead and set up a Time Domain (Transient) Analysis, setting parameter values that appropriate.  The results should look something like shown in Figure 45.
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Figure 45


Let’s say we want to know the frequency of the underdamped oscillatory response. This can be done using the cursors as follows:

· First, let’s run the simulation again by selecting PSpice(Edit Simulation Profile.  Set the maximum step size at 2 nanoseconds.  This will allow for better accuracy of the minimum and maximum points of the oscillation.

· See Figure 46 for an expanded view of this part of the step response with a 2 nanosecond maximum step size.

· Figure 46 also shows the use of cursors.  In this case cursor A1 is set on the maximum value of the step response, A2 is set on the minimum value of the step response after it starts oscillating.  There difference is shown in the cursors window as about 88 nanoseconds.  Double that value will give us a period of the oscillation of 176 nanoseconds.  The reciprocal of this value is 1/176 nanoseconds =  5.68 x 106 (5.68 MHz).
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Figure 46

Diode Circuit Simulation

Now let’s create a simple circuit with a diode and use a Probe feature to produce a classic diode transfer graph of the diode current (ID) vs. diode voltage (VD).  Build the circuit shown in Figure 47.  This should be easy for you to do now. When you create this Project, create a folder called “Diode” and call the Project “Diode”.  Make sure you include the diode.slb library when you do this.   Note that the diode is the D1N4148/27C.

Now do a DC Sweep analysis.  Set the sweep to be from 0 volts to 30 volts.  Set the voltage increment at 0.1 volts.  Figure 48 shows the results of this analysis.
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Figure 47
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Figure 48
This depiction of the response of the diode is not very satisfying.  It would be better if we could have a depiction of ID vs. VD, just like you see in a textbook.  This can be done in Probe. How?  Let’s look at it.  First, click on V(V1:+) and delete the trace via pressing the Delete key or CTRL-X.  Click in the same way on V(D1:1) and delete it.   Next, set the X-axis variable to be V(D1:1):

· Go Plot(Axis Settings.  Then select Axis Variable and click on V(D1:1), then click “OK”.  This changes the X-axis variable from V_V1 to the diode voltage.

· Now Go Trace(Add Trace.  Then select I(D1).  This will produce the desired effect, as shown in Figure 49.  
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Figure 49

This same type of operation can be done on other circuits.  You have a lot of flexibility in what you can display.    Note that the a point that corresponds with VD of 0.7 volts and ID of 13.5 milliamps has an ellipse drawn around it.  This can be implemented via going Plot(Label(Ellipse.  Once selected, the placing and sizing of this ellipse works like Microsoft Word or Microsoft Paint.

Transistor Circuit Simulation

Create another Project named Transistor and name a new folder with the same name.  When this new project is created, make sure that you include the bipolar.slb library.

Figure 50 shows the transistor circuit using the 2N3904 part and applying a sinusoidal transient input.  The voltage source VSIN is a transient signal that is a sinusoid rather than a square wave pulse. Let’s look at the parameters for this source. VOFFis the offset voltage (dc) value for the sinusoidal source;  VAMPL is its amplitude in volts;  FREQ is the frequency of this sinusoid in hertz.
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Figure 50
When the transient analysis is done, with a maximum step size of 10 (s.  This is shown in Figure 50.

Signal at the collector terminal.       Signal across RL.     Input Signal.
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Figure 50
Of course, there are many more capabilities available in Capture, PSpice, and Probe. These are available to you to explore.  

Monte Carlo Analysis
Monte Carlo Analysis is a powerful way to analyze a circuit statistically to get a view of how expected variations in component values will be expected to affect the performance of the circuit.  In order to implement this analysis on a circuit, the following basic steps must be taken:

· Change regular components to  breakout components (Rbreak, Cbreak, etc.)

· Edit the .MODEL statements for these breakout components so that they properly represent the expected variations in the components.

· Set up the Monte Carlo sub-analysis parameters in the Monte Carlo/Worst Case text box.

· Run the analysis

· Make use of the Performance Analysis option under the Trace menu item in the Probe window to see how circuit functions are affected by the variations in the component values.

Monte Carlo analysis is very helpful when engineers want to get a near-real picture of what to expect of a particular design in a manufacturing situation, i.e., when the full spectrum of components are experienced on the manufacturing floor.  

For our example we will use the basic RC circuit utilized earlier in this tutorial.  We want to investigate how the rise and fall times of this circuit’s step response may be expected to vary.

Build the Circuit

First of all, use Capture to build the circuit shown in Figure 52.  Set up the Analysis for a transient response with a 3 (s pulse width and a period of 6 (s.  Set the time of the analysis to 6000ns (6 (s) and the maximum step size to 10 nanoseconds as shown in Figure 53.  Take note of the Voltage Marker. When you set up the analysis click on the Data Collection Tab and choose At Markers Only.  Also note the net alias of Vout to make identification of the output node on the capacitor C1.
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Figure 52
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Figure 53

If you were to do a regular analysis at this point, then the results would be as has been demonstrated earlier in this tutorial. Now this circuit needs to be converted to one on which the Monte Carlo analysis can be done.  To make this conversion do the following:

· Delete R1 and C1.

· Go Place(Part…
· Make sure that the breakout.slb library is selected and type in or select Rbreak.

· Place the breakout resistor symbol in the location previously occupied by R1

· Change the reference of this new part from R2 to R1.

· Go Place(Part…
· Make sure that the breakout.slb library is selected and type in or select Cbreak.

· Place the breakout capacitor symbol in the location previously occupied by C1

· Change the reference of this new part from C2 to C1.  See Figure 54. 

[image: image48.png]OiCAD Capture
Fle Edt View Place Mavo PSpice Accessories Optins Window Help

=18l x]

o = = = B = M R e Y[ e e = A T

5] = 2]

= =1 A PPl g b
T
s MonteCarloopi ETES | 917 - SCHEMATIC) : PAGE1)

Anelog or A/D Mired Mode

=10fx]

O Fie |8, Hiarchy
3 Deson Resaurces
merizcato dsn

ray
CProgram Fies\0r

~
=
IC}

CAProgam FlestOi
CAProgam FlestOi
CAProgiam FlestOi

Amantecatlo.olb

€ oups B
mortecatoschemaic. =

€3 Pice Resauces =
£ Include Fies =
580 ModelLbraizs —
montecatoli id

€2 Simialion rfies ~
£ Stimulus Files. i
o

5 S
- 2|
Al

0% %=250 V=230

[Tem selesied— [Sok




Figure 54
· Select R1 and then go Edit(PSpice Model…
· Change the name of Rbreak to RMonte1 by double clicking on Rbreak in the text box and typing the new name RMonte1.

· Make other changes in the .MODEL line so that it reads as shown here:

.model RMonte1 RES R=1 DEV=2% LOT=10%

R=1 is the multiplicative factor with a default of 1 k(. DEV=2% says that this resistor is expected to have a 2% variation itself and LOT=10% indicates that the variation between different LOTS of  resistors will be 10%. 

· Select C1 and then go Edit(PSpice Model…
· Change the name of Cbreak to CMonte1 by double clicking on Cbreak in the text box and typing the new name CMonte1.

· Make other changes in the .MODEL line so that it reads as shown here:

.model CMonte1 CAP  C=1 DEV=10% LOT=10%

C=1 is the multiplicative factor with a default of 1 nF. DEV=10% says that this capacitor is expected to have a 10% variation itself and LOT=10% indicates that the variation between different LOTS of capacitors will be 10%. 

· Click Monte Carlo/Worst Case under Options in the Simulation Settings text box.

· Now make the changes in the Monte Carlo/Worst Case text box as shown in Figure 55.
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Figure 55
· The number of runs is set at 10 to keep the analysis time fairly small. With this kind of analysis, the size of the output file grows linearly with the number of Monte Carlo runs.

· The V(Vout) Output variable selection is chosen to match up with the net alias in the circuit. Note that the Monte Carlo analysis has been selected also.

· Now run the analysis.  The results should look like What is displayed in Figure 56.
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Figure 56

This figure shows the 10 individual runs that were done as part of this analysis.  This gives you a good feel for how we might expect the circuit performance to vary over a certain amount of variation.  A more confident results can be gotten by increasing the number of runs to, say, 20 or 40, or even 50.   You can experiment with this.

There is one more useful tool that can be used in association with  Monte Carlo Analysis.  That is the Performance Analysis option.  Here how to do it.

· Go Trace(Performance Analysis…
· This opens up the option of using the Wizard to define what you want to analyze. Click on Wizard.

· Click Next

· Select Risetime and click Next

· Click on the icon of  Name of Trace to Search.

· From this text box select V(Vout) and click OK

· Click Next

· Click Next again, which should finish the Wizard.

· Now you should see a histogram that shows the distribution of the 10 calculations of the risetime of this circuit. This is shown in Figure 57.  

[image: image51.png]2 m
p 48
¢
t
20
SEL>>
[
1.50 1.6u 1.7u 1.8u 1.9u 2.00 2.1u
Risetine(U(Vout))
n sanples signa 1.1051e-007 median - 1.83466e-006

nininun
16th %ile

n divisions
nean

1.58303e-006 96th %ile
1.65038¢-006 naxinun

1.94502¢-006
1.95357e-006

1.00

0.5

(3 1.00s 2.0us 3.0us u.0us 5.0us 6.0us
i ae ek av o+ UQUOUTY
Tine





Figure 57

In looking at the statistics of this histogram you will note that the average rise time is said to be 1.80995 microseconds.  Yet according to theory, the rise and fall time of such a circuit should be equal to 2.2 times the time constant, where the time constant ( is RC.  Yet RC in this case is 1 k( times 1 nanofarads = 1 (Seconds.  2.2 times that is 2.2 (Seconds, a bit off from what we see in the figure.  The trick is that the rise time here is determined on the very first rising edge, when the voltage began with an initial condition of 0 volts; thereafter, the rise and fall times will not include starting from 0 volts or starting from 1 volt. This will change the rise time value.  You can check this by going back and having the performance analysis be done on fall time instead of rise time. This different tack on the analysis will provide the right answer  (about 2.2 (Seconds).  This is shown in Figure 58.  
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Figure 58

Look right here (
This should give you a good start on the use of Monte Carlo Analysis.

Worst Case Analysis

Worst Case analysis is similar to Monte Carlo analysis.  A detailed explanation of this type of analysis will not be covered at this time.  You can learn more about it by reading the OnLine documentation on PSpice.  Happy Analyzing!!
NOTE:  The Online version of this tutorial does not contain Appendix A
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